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Workspace ONE UEM Installation Overview
TheWorkspace ONE UEMWindows Installer allows you to install Workspace ONE UEM components onto application
servers to meet your deployment needs.

The installer handles theWorkspace ONE UEM console server components, the Devices Services server components.
FromWorkspace ONE UEM v9.4, the installer does not include installation files for the VMware Identity Manager service.

VMware Identity Manager Installation

If you are running VMware Identity Manager as part of your deployment ofWorkspace ONE UEM, you must set up
Identity Manager before you install Workspace ONE UEM components.

To install and configure VMware Identity Manager, see the Identity Manager documentation at
https://docs.vmware.com/en/VMware-Identity-Manager/3.2/vidm-install.pdf.

Installation Preparation

Installing Workspace ONE UEM requires specific prerequisites and procedures in an on-premises solution. Make sure to
meet the prerequisites before proceeding with the installation instructions.

For detailed instructions on preparing for installation, see Installation Preparation Overview on page 10.

The installation preparation procedure features a new tool, theWorkspace ONE Validation Tool on page 29, which
provides feedback on your readiness to proceed with installation.

Database and Application Server Installations

Installing Workspace ONE UEM on premises involves configuring servers for your database, application, and any auxiliary
components, and reports. Workspace ONE UEM comprises several different components, which can be combined with
application servers or installed on their own dedicated servers.

To begin the database server installation, see Database Server Installation Overview on page 40.

To begin the application server installation, see Run theWorkspace ONE UEM Installer on Each Application Server
(Console and Device Services) on page 44.

Reports Installation and Storage

Installing Workspace ONE UEM on premises involves installing and configuring reporting functionality for your
deployment. After the reporting functionality is set up, you must configure storage for the reports that Workspace
ONE UEM generates.

To install and configure reports, seeWorkspace ONE UEM Reports Overview on page 59.

Installation Verification

After Workspace ONE UEM is installed and configured, verify that all the components you have installed function
properly.

To verify your installation, see Installation Verification Overview on page 64.

Next Steps

When your installation is finished, Run theWorkspace ONE Wizard on page 69.

Chapter 1: Overview
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Recommended Architecture

To review recommended architectures based on your deployment size, refer to the VMware Workspace ONE UEM
Recommended Architecture Guide, available at docs.vmware.com.

Before you Begin Checklist
Be aware of several notes and caveats before attempting to install Workspace ONE UEM on premises. Read through the
following sections and ensure that you are fully prepared for following the steps in the remainder of this guide.

Obtain the Latest Version of this Document

Ensure that you are using the latest version of this guide by downloading the latest copy of the document from
docs.vmware.com. Workspace ONE UEM frequently makes updates to documentation and having the latest version
ensures that you are following the best practices and procedures.

Obtain the Install Package Files

Ensure that you have downloaded the installation package files. The link to these files is provided to you by your
Workspace ONE UEM consultant as part of the deployment process.

Meet the Requirements

Meet all the requirements needed for a Workspace ONE UEM installation. Specific hardware and software requirements
are outlined in theWorkspace ONE UEM Recommended Architecture Guide, available on docs.vmware.com. A list of
other requirements can be found in the Installation Preparation Overview on page 10.

Note: As of AirWatch v9.1 we have changed our supported SQL versions. Please check the latest list of prerequisites in
the Recommended Architecture Guide to ensure your current version is supported.

Verify your On-Call Resources

Ensure that you have the proper on-call resources available if you need them. These resources may include technical
resources such as the Database Analyst, ChangeManager, Server Administrator, Network Engineer, and MDM System
Administrator.

Workspace ONE UEM Components

To streamline theWorkspace ONE UEM installation process, this document refers to both theWorkspace ONE UEM
console server and Workspace ONE UEM Device Services server. Before proceeding, it is important to understand each of
these components and what they mean to your specific topology model.

l TheWorkspace ONE UEM console Server refers to the component ofWorkspace ONE UEM that renders and
displays the UEM console. It presents and sends data to the database directly from theWorkspace ONE UEM
console.

Chapter 1: Overview
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l TheWorkspace ONE UEM Device Services Server refers to the component ofWorkspace ONE UEM that
communicates with all managed devices. This server runs all processes involved in receiving and transmitting
information from devices to other components of the system.

l The VMware Identity Manager Server refers to the component ofWorkspace ONE UEM that enables Workspace
ONE functionality. This server provides services required for theWorkspace ONE application and brand new
functionality like mobile single sign-on and conditional access for third-party applications.

As ofWorkspace ONE UEM 9.4, the installer for the VMware Identity Manager is separate from theWorkspace
ONE UEM installer. This document details where you need to transfer to the Identity Manager documentation to
complete your setup. Vmware Identity Manager documentation is available on docs.vmware.com.

l TheWorkspace ONE UEM Application Server is any server that runs a Workspace ONE UEM instance. The standard
Workspace ONE UEM deployment method involves installing multiple application servers for these components
alongside a database. For each procedure in this guide that references an Application server, complete the procedure
on all Workspace ONE UEM servers (Console, Device Services, AWCM, API).

l This document assumes that you are using one of the recommended architectures as detailed in theWorkspace
ONE UEM Recommended Architecture Guide, available on docs.vmware.com. If you are not using one of these
architectures, contact VMware AirWatch for additional assistance.

A Note About Screenshots in this Document

Where applicable, this document uses screenshots fromWindows Server 2012. If you are using Windows Server 2008 R2
or 2016, then perform the same actions documented in this guide, with the knowledge that the exact steps may slightly
differ.

Installation Procedure Checklist for Workspace ONE with Workspace ONE
UEM and VMware Identity Manager (Windows Installer) Components
Use the following checklist to track your installation progress for theWorkspace ONE system by integrating Workspace
ONE UEM and VMware Identity Manager (Windows installer).

Status
Checklist

Requirement

Step 1: Prepare for Your Installation

Verify Database Server Prerequisites AreMet for both VMware Identity Manager and Workspace ONE
UEM

Verify Application Server Prerequisites AreMet for Workspace ONE UEM

Verify Identity Manager Service Server Prerequisites AreMet

Perform Optional Installs for Workspace ONE UEM

Create theWorkspace ONE UEM Database

Assign Workspace ONE UEM Database Roles

Create the VMware Identity Manager Database

Chapter 1: Overview
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Status
Checklist

Requirement

Assign Identity Manager Database Roles

Configure Application Servers for Workspace ONE UEM

Server Internal DNS and Certificate Requirements for Workspace ONE UEM

Server External DNS and Certificate Requirements for Workspace ONE UEM

Stage Install Files for Workspace ONE UEM

(OPTIONAL) Run theWorkspace ONE Validation Tool

Step 2: Perform the Database Installation

Run theWorkspace ONE UEM Database Setup Utility

Verify Proper Database Installation

Step 3: Perform Application Server Installation

Start theWorkspace ONE UEM Installer on Each Application Server

(IF APPLICABLE) Run theWorkspace ONE UEM Installer on Any Additional Device Services Servers

(IF APPLICABLE) Run theWorkspace ONE UEM Installer on Identity Manager Server

Step 4: Perform Reports Installation

Integrate Reports with the Console and Enable Reports Storage

This guide does not cover post-install configuration, but does include a Post-Installation Steps Overview on page 69,
which covers some of the essential procedures to get you started.

Chapter 1: Overview
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Installation Preparation Overview
Installing Workspace ONE UEM requires following specific prerequisites and procedures for an on-premises solution.
Make sure to meet the prerequisites before proceeding with the installation instructions.

Prepare for installation by completing the following:

1. Database Server Prerequisites on page 10

2. Application Server Prerequisites on page 12

3. Perform Optional Installs on page 14

4. Workspace ONE UEM Reports Overview on page 59

5. Create theWorkspace ONE UEM Database on page 15

6. Create theWorkspace ONE UEM SQL Service Account and Assign DB Owner Roles on page 15

7. Configure your Application Servers on page 18

8. Configure Your Internal DNS Record and Certificates on page 19

9. Configure Your External DNS Record and Certificates on page 23

10. Stage Install Files on page 29

11. Workspace ONE Validation Tool on page 29

Database Server Prerequisites
Meet the database server prerequisites before installing the database server. The prerequisites listed here apply to any
database you plan to install (for example, theWorkspace ONE UEM or VMware Identity Manager databases).

SQL Server Hardware Requirements

The exact specifications needed for your SQL server depend on the size and needs of your deployment. Gather this
information before proceeding so you size your servers correctly. Read theWorkspace ONE UEM Recommended
Architecture Guide, available at docs.vmware.com, for hardware sizing information and other technical details that
ensure the smooth operation of yourWorkspace ONE UEM database.

SQL Server Software Requirements

Meet the following SQL Server software requirements:

l SQL Server 2012, SQL Server 2014, or SQL Server 2016with Client Tools (SQL Management Studio, Reporting Services,
Integration Services, SQL Server Agent, latest service packs). Ensure the SQL Servers are 64-bit (OS and SQL Server).

Workspace ONE UEM does not support Express, Workgroup, or Web editions of SQL Server. These editions do not
support all the features used in theWorkspace ONE UEM application. Currently only Standard and Enterprise
Editions are supported.

l Microsoft SQL Server 2012 Native Client 11.3.6538.0 is required to run the database installer. If you do not want to
install Microsoft SQL Server 2012 Native Client 11.3.6538.0 on to your database server, then run the database

Chapter 2: Installation Preparation
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installer from another AirWatch server or a jump server whereMicrosoft SQL Server 2012 Native Client 11.3.6538.0
can be installed.

l .NET 4.6.2 is required to run the database installer. If you do not want to install .NET on to your database server,
then run the database installer from another Workspace ONE UEM server or a jump server where .NET can be
installed.

l Ensure the SQL Server Agent Windows service is set to Automatic or Automatic (Delayed) as the Start type for the
service. If set to Manual, it has to bemanually started before database installation.

l You must have the access and knowledge required to create, back up, and restore a database.

When the database installer runs, it automatically updates your SQL Server with the latest versions of:

l ODBC Driver 13 for SQL Server 64-bit

l Command Line Utilities 13 for SQL Server 64-bit

TCP/IP Enabled

Use TCP/IP to connect to the database and disable Named Pipes. In SQL Server Configuration Manager, navigate to
SQL Server Network Configuration and select Protocols for MSSQLSERVER.

SQL Server AlwaysOn

The SQL Server AlwaysOn capability combines failover clustering with databasemirroring and log shipping. AlwaysOn
allows for multiple read copies of your database and a single copy for read-write operations.

For more information about AlwaysOn functionality, see https://msdn.microsoft.com/en-us/library/ff877884.aspx.

If you have the bandwidth to support the traffic generated by Workspace ONE UEM, theWorkspace ONE UEM database
supports AlwaysOn. The following AlwaysOn functionality has been tested for support:

Chapter 2: Installation Preparation
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l Database in an Availability Group

l Availability Group failover

l Secondary Replica promotion to Primary

l Synchronous Replication

AlwaysOn Prerequisites

To integrate SQL Server AlwaysOn, set up the following prerequisites:

l Create a database listener to integrate with theWorkspace ONE UEM Application and Database installations.

For more information on creating a database listener, see https://docs.microsoft.com/en-us/sql/database-
engine/availability-groups/windows/create-or-configure-an-availability-group-listener-sql-server.

l If your AlwaysOn Availability Group uses different network subnets, you must configure your Availability Group
Listener settings before you can deploy Workspace ONE UEM. Run the following commands using PowerShell on
each database server in your cluster before you run the database installer:

>Get-ClusterResource <AG Listener Resource Name> | Set-ClusterParameter -Name
HostRecordTTL -Value 60

>Get-ClusterResource <AG Listener Resource Name> | Set-ClusterParameter -Name
RegisterAllProvidersIP -Value 0

For more information about HostRecordTTL values, including how to retrieve the AG Listener Resource Name, see
https://blogs.msdn.microsoft.com/alwaysonpro/2014/06/03/connection-timeouts-in-multi-subnet-availability-
group/.

Your database administrators decide the value for the HostRecordTTL. Low values result in a faster reconnection
after a fail-over. For example, with a value of 60, the listener's DNS record updates take up to 60 seconds to match
the IP address of the Primary (Active) SQL Node after a SQL fail-over.

Application Server Prerequisites
Meet the application server prerequisites before installing the application server. The prerequisites listed here apply to
any application server you plan to install.

Hardware Requirements

AWorkspace ONE UEM installation can involvemany servers, and the exact specifications depend on the size and needs
of your deployment. You may need to gather this information before proceeding so you size your servers correctly. Read
through theWorkspace ONE UEM Recommended Architecture Guide, available at docs.vmware.com., for hardware
sizing information and other technical details that ensure the smooth operation of yourWorkspace ONE UEM solution.
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Network Requirements

Review all the network requirements as outlined in theWorkspace ONE UEM Recommended Architecture Guide. These
requirements include the firewall ports that must be opened for Workspace ONE UEM to function properly.

Software Requirements

Ensure that you meet the following software requirements for the application servers:

l Internet Explorer 9+ installed on all application servers

l Windows Server 2008 R2, Windows Server 2012, Windows Server 2012 R2, or Windows Server 2016

l 64-bit Java (JRE 1.8) server needed for the server on which AWCM is installed. The Java installer is packaged with the
Workspace ONE UEM installer and installs automatically if it is not already present.

l 64-bit Java (JRE 1.8) installed on all app servers. The Java installer is packaged with theWorkspace ONE UEM installer
and installs automatically if it is not already present.

l .NET Framework 4.6.2. The .NET Framework 4.6.2 installer is packaged with theWorkspace ONE UEM installer and
installs automatically if it is not already present.

l PowerShell version 3.0+ if you are deploying the PowerShell MEM-direct model for email. To verify your version,
open PowerShell and run the command $PSVersionTable. More details on this and other email models are
available in theWorkspace ONE UEM Mobile Email Management Guide, available at docs.vmware.com.

l Microsoft SQL Server 2012 Native Client 11.3.6538.0 to run the database installer. If you do not want to install SQL
Server 2012 Native Client, run the database installer from another UEM server (or a jump server) whereMicrosoft
SQL Server 2012 Native Client 11.3.6538.0 can install.

l If you useWindows for SQL authentication, you must join application servers that talk to the database to the
Windows user's domain. The Active Directory service account must have administrator-level permissions.

Proxy Requirements

TheWorkspace ONE UEM servers can be configured with a proxy / PAC file for outbound Internet access. Apple APNs
traffic, however, is not HTTP traffic, and cannot be authorized through traditional HTTP proxies. This traffic must go
straight out to the Internet or through an application/SOCKS proxy.

If you are performing outbound proxying of APNs messages, your proxy application must support SOCKS V5.

SOCKS V4 and SOCKS V4a are not supported.

Install Role from Server Manager

Ensure that you meet the following IIS requirements, depending on yourWindows Server version:

l IIS 7.0 (Server 2008 R2)

l IIS 8.0 (Server 2012 or Server 2012 R2)

l IIS 8.5 (Server 2012 R2 only)

l IIS 10.0 (Server 2016)

See additional information on the required roles and features under Configure your Application Servers.

Chapter 2: Installation Preparation
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RDP and VM Access to Application Servers

You must have remote access to the servers that Workspace ONE UEM is installed on. Verify this access before
attempting to install Workspace ONE UEM servers.

Remote Desktop Connection Manager can be downloaded from the following link:

https://www.microsoft.com/en-us/download/details.aspx?id=44989

Verify you can connect using RDP to your application servers or appropriate VM hosts.

1. Open Remote Desktop Connection:

l Start > Run

l Typemstsc

l Select OK

2. Enter the IP address of the server and select Connect.

3. Log in using credentials for the server. Verify a successful log-in.

Permissions of Workspace ONE UEM Service Accounts

The service account you create for Workspace ONE UEM needs the appropriate permissions to integrate with your back
end systems. This can be one service account that has all required access. Verify connectivity between yourWorkspace
ONE UEM service account and your backend systems.

Perform Optional Installs
Install optional software to ensure a smooth installation process and to make troubleshooting easier.

Supported Browsers

TheWorkspace ONE Unified Endpoint Management (UEM) console supports the latest stable builds of the following web
browsers.

l Chrome

l Firefox

l Safari

l Internet Explorer 11

l Microsoft Edge

Note: If using IE to access the UEM console, navigate to Control Panel > Settings > Internet Options > Security and
ensure you have a security level or custom security level that includes the Font Download option being set to
Enabled.

Chapter 2: Installation Preparation
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If you are using a browser older than those listed above, upgrade your browser to guarantee the performance of the
UEM console. Comprehensive platform testing has been performed to ensure functionality using these web browsers.
The UEM consolemay experienceminor issues if you choose to run it in a non-certified browser.

Notepad++

Download and install Notepad++ (http://notepad-plus-plus.org/). This application is helpful because it allows you to view
many log files at once using the tabular format and allows for the auto-refresh of a log file if it is regenerated.

Create the Workspace ONE UEM Database
To create the database, you must perform the following steps with an administrator account that has the correct
read/write permissions.

1. On the SQL Server, open SQL Server Management Studio.

2. Log in using your user name and password.

3. Click Connect.

4. Right-click Databases and select New Database.

5. EnterWorkspace ONE UEM as the Database name.

6. Scroll to the right side of Database files, select the… next to Autogrowth for Workspace ONE UEM, and change File
Growth to “In Megabytes” and the size to 128, then select OK.

7. Select Options, and set the Collation to SQL_Latin1_General_CP1_Cl_AS.

8. Select OK to create theWorkspace ONE UEM database.

9. Expand Databases and verify theWorkspace ONE UEM database is created.

Create the Workspace ONE UEM SQL Service Account and Assign DB Owner
Roles
After you create theWorkspace ONE UEM database, you must configure the credentials of the SQL user that will run the
Workspace ONE UEM database setup utility.

1. Open SQL Server Management Studio.

2. Log in to the DB server containing theWorkspace ONE UEM database.
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3. Navigate to Security > Login, right-click, and select New Login.

4. Select whether to use aWindows account or local SQL Server account for authentication. For SQL Server
authentication, enter your user credentials.

5. Select theWorkspace ONE UEM database as theDefault database.

6. Navigate to the Server Roles tab. Select server role as Public.

7. Select User Mapping.

l Select theWorkspace ONE UEM Database. Then, select the db_owner role.

For a successful installation, you must ensure that the SQL User you are planning to run theWorkspace ONE
UEM Database Script with has the database db_owner role selected.

Chapter 2: Installation Preparation
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l Select themsdb Database. Then, select the SQLAgentUserRole and db_datareader roles. SQLAgentUserRole is
not pictured below due to space constraints.
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8. Select OK.

Configure your Application Servers
TheWorkspace ONE UEM installer configures the following roles and permissions as part of the installation. If you prefer
to configure thesemanually, or to verify them, you can use the procedure below.

1. On theWorkspace ONE UEM console Server andWorkspace ONE UEM Device Services Server, from the Taskbar,
open Server Manager and selectManage > Add Roles and Features. Click Next to advance to the Server Roles tab.

2. Expand Web Server (IIS), and under it expand Web Server.

3. Verify that the following role services are enabled (most may already be enabled):

l Common HTTP Features: Static Content, Default Document, HTTP Errors, HTTP Redirection

l Application Development: ASP.NET, .NET Extensibility, ASP, ISAPI Extensions, ISAPI Filters, Server Side Includes

When ASP.NET is selected, select Add Required Features to associate features with the ASP framework. Ensure
that other required role services are enabled.

l Health and Diagnostics: HTTP Logging, Logging Tools, Request Monitor, Tracing

Chapter 2: Installation Preparation
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l Security: Request Filtering, IP, and Domain Restrictions

l Performance: Static Content Compression, Dynamic Content Compression

l Management Tools: IIS Management Console and IIS 6Metabase Compatibility

l EnsureWebDAV is not installed.

4. Click Next.

5. On the Features tab, verify the following required features are added:

l .NET Framework 4.6.2 Features: Entire module (.NET Framework and WCF Activation)

When .NET is selected, select Add Required Features, to associate features with the .NET framework. Expand to
verify every .NET/WCF feature is enabled. For a 2012 R2, .NET Framework 4.6.2 Features is required.

l Message Queuing: Message Queuing Server (expand Message Queuing >Message Queuing Services to select)

l Telnet Client

6. Click Next and verify that the features which must be enabled have been so enabled.

7. Select Install.

8. When the installation is finished, verify that the Installed succeeded messages are shown, then select Close.

Install URL Rewrite Module 2.0

The URL RewriteModule 2.0 cannot be installed until the IIS role is installed.

1. Navigate to http://www.iis.net/downloads/microsoft/url-rewrite#additionalDownloads and download the
appropriate version for your install.

2. Run the installer and accept the defaults for installation.

Configure Your Internal DNS Record and Certificates
An internally registered DNS record is for devices connecting over your organization's internalWi-Fi network, and it tells
them how to connect to Workspace ONE UEM (specifically, the Device Services server). An internal DNS record must be
registered on the internal domain server.

In the standard, multi-server deployment, you must generate a self-signed certificate for your Console server (or you can
use an internally issued certificate).

The externally available URL of theWorkspace ONE UEM server must be set up with a trusted SSL certificate. Awildcard or
individualWeb site certificate is required.

1. Open Server Manager and navigate to Roles > Web Server (IIS).

2. Click the Server Name.

3. Double-click Server Certificates.
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4. On the right, select Create Self-Signed Certificate.

5. Enter the friendly name (FQDN) and select OK.
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6. Next you can add a 443 binding to the Default Web site in IIS. The bindings for a completed server look like the
following. Your SSL certificate appears in the drop-down menu of available certificates.
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7. Also verify that you have a private key that corresponds to your certificate.
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Configure Your External DNS Record and Certificates
The two main components ofWorkspace ONE UEM are the Device Services server and the Console server. In the
standard deployment model, these components are installed on separate servers, and only the Device Services
component requires an external DNS record, while the Console component can remain only internally available.

An externally registered DNS record is a friendly name that refers to the IP to tell external devices how to connect to
Workspace ONE UEM (the Device Services server). This externally available URL must be set up with a trusted
SSL certificate trusted by all device types. For Apple, you can see a list of root certificates natively trusted by iOS On the
Apple Support webpage. For other OEMs, check with the OEM to see which third-party certificate authorities are natively
trusted. You can also typically retrieve this information from the device by looking for the Trusted Root CAs under
Settings.

Awildcard or individual website certificate is required.

Important: Ensure that these steps are performed on both theWorkspace ONE UEM console and Device Services
servers.

1. Obtain SSL certificates for each of your external DNS entries. A list of root certificates natively trusted by iOS can be
found here: http://support.apple.com/kb/HT5012

2. On theWorkspace ONE UEM console and Device Services Servers, openMMC:

a. Start > Run

b. Type mmc

c. Select OK

3. In MMC, navigate to File > Add/Remove Snap-in …

4. Select Certificates from the list of add-ins and select Add.

5. Choose Computer account and select Next.

6. Keep Local computer selected and select Finish and OK.
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7. Expand the Certificates folder and right-click Personal.

8. Select All Tasks and choose Import.

9. In the Certificate Import Wizard, select Next and perform the following steps:

a. Click Browse and navigate to the Cert folder, which was staged earlier, and change the file type drop-down to All
Files.

If the drop-down is not changed to All Files, the certificate cannot be selected for import.

b. Select the appropriate certificate and select Open.

In a standard, multi-server installation, this certificate is the external third-party certificate for the DS server and
for the Console it can be a self-signed or internally issued certificate.

This certificatemust be a PFX file.

c. Click Next, and complete the following settings:

l Password: Your certificate password

l EnableMark this key as Exportable

(This setting is optional and allows you to export the certificate from this server to use it on another server.)

l Enable Include all extended properties

d. Click Next and select Finish.

e. Select OK to close the “The import was successful” pop-up.

10. Expand the Personal folder to show the Certificates folder.

11. Drag the Root CA Certificate into the Trusted Root Certification Authorities folder. Navigate to Trusted Root
Certification Authorities > Certificates and verify that themove was successful.
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12. Navigate back to Personal > Certificates, and drag the Intermediate CA Certificate into the Intermediate
Certification Authorities folder. Navigate to Intermediate Certification Authorities > Certificates and verify that the
move was successful.

13. To closeMMC, select File > Exit . Select No to save changes.

14. Open Server Manager, select Roles and expand:Web Server (IIS) > Information Services (IIS) Manager.

15. In the right pane, under Connections, select the server.

16. Under the IIS section, double-click on Server Certificates and verify that the certificate is located in the certificate list.
An example is shown.

Once uploaded on your server you can use it to add a 443 binding to the Default website in IIS. Your SSL certificate
appears in the drop-down menu of available certificates.

17. Under Connections, expand Sites and select Default Website.

18. Under Actions, to the far right side, under Edit Site, select Bindings and select Add…
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19. Configure the following settings:

l Type: https

l SSL certificate: Your certificate

20. Click OK and select to Close.

The IP address and Port are not altered. Do not populate the Hostnamewith an IP or DNS entry, since it affects the
functionality of the SSL binding. A slight delay occurs when the certificate is bound to the website.

21. Click OK and select to Close.

22. Under Actions/Browse Website, verify Browse *.443 (https) is an available option.

23. Also verify that you have a private key that corresponds to your certificate.
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24. Verify that the certificate contains the common name in the subject.

25. Verify that your DNS name is listed in the Subject Alternative Name.
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26. Validate that you can connect to the server over HTTPS (https://[yourUEMDomain].com). At this point, the IIS splash
page displays.

Important: If SSL is used for UEM console access, ensure that FQDN is enabled.
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Stage Install Files
After meeting the database and application server prerequisites and configuring your internal and external DNS, you can
stage the install files on the appropriate Console, Device Services, and SQL servers.

To stage the install files: 

1. Download the latest GA or Feature Pack Full Installer.zip file from the Resource Portal. Receive a direct link to the files
from yourWorkspace ONE UEM consultant as part of the deployment process.

2. Unzip the files on to the appropriate server.

3. Extract the contents.

Workspace ONE Validation Tool
Use theWorkspace ONE Validation Tool to verify that your system and components are properly configured.

TheWorkspace ONE Validation Tool analyzes configuration data from the target AirWatch and Workspace ONE
environments to validate that your environment is ready for a successful SaaS or on-premises deployment.

The utility validates the Database, Console, Device Services, AirWatch Cloud Messaging, VMware Enterprise Systems
Connector, Secure Email Gateway, and Email Notification Service. Each of these components has different software and
networking requirements, such as OS, Database, CPU, RAM, JRE, network security, Server Manager, DNS, certificates,
and Email infrastructure.

The tool generates a customized report that validates that the environment is deployment-ready.

You can check your configuration to perform:

l A system health check.

l A validation before or after an install or upgrade to your AirWatch version.

l Troubleshooting on network changes.

l A validation before or after a server migration.

To begin the installation validation, download theWorkspace ONE Validation Tool from https://resources.air-
watch.com/view/vldrj3p3fb8mvzmrpj84. Extract the ZIP file and open theWorkspaceONEValidationTool.exe file.

Next, select a component to validate:

l Validate theWorkspace ONE UEM Console on page 30

l Validate the VMware Device Services on page 31

l Validate the Email Notification Server on page 32

l Validate the VMware Enterprise Systems Connector on page 33

l Validate the Secure Email Gateway on page 35

l Validate VMware Identity Manager on page 35
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Validate the Workspace ONE UEM Console

Use theWorkspace ONE Validation Tool to verify that your Windows machine is properly configured for a deployment of
theWorkspace ONE UEM console.

1. Run theWorkspace ONE Validation Tool. Select Console.

2. Enter the following console information. Select Next at the end of each page.

a. Host URL

b. Database server

c. Database name

d. Authentication type: select SQL Server orWindows

e. Database user

f. Database password

g. Outbound connections by proxy: select Yes orNo

o If you select Yes, enter the Proxy URL and Proxy port, and select the Authentication type.

o If your authentication type is Password, enter theUser name, Password, and Bypass List information for
your authentication strategy.

h. System integration configurations: select Yes orNo to connect your back-end resources to the console.

o If you select Yes, select the System Integration you want to configure, and enter the required integration
information for your selection.

3. When you have entered all the required information, select Test to verify your Console configuration.
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4. When the test results appear, you can Export the results or Retry the validation. For more information about using
the results, see Validation Tool Results on page 36.

If the validation returns errors, consult the Pre-Installation Requirements Worksheet, available at https://resources.air-
watch.com/view/yjs9gxm5262g4vh3l7v4/en.

Validate the VMware Device Services

Use theWorkspace ONE Validation Tool to verify that your instance of VMware Device Services is properly configured.

1. Run theWorkspace ONE Validation Tool. Select theDevice Services option.

2. Enter the following Device Services information. Select Next at the end of each page.

a. Host URL

b. Database server

c. Database name

d. Authentication type: select SQL Server orWindows

e. Database user

f. Database password

g. Outbound connections by proxy: select Yes orNo

o If you select Yes, enter the Proxy URL and Proxy port, and select the Authentication type.

o If your authentication type is Password, enter theUser name, Password, and Bypass List information for
your authentication strategy.

h. System integration configurations: select Yes orNo to connect your back-end resources to Device Services

o If you select Yes, select the System Integration that you want to configure and enter the required integration
information for your selection.
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3. When you have entered all the required information, select Test to verify your Device Services configuration.

4. When the test results appear, you can Export the results or Retry the validation. For more information about using
the results, see Validation Tool Results on page 36.

If the validation returns errors, consult the Pre-Installation Requirements Worksheet, available at https://resources.air-
watch.com/view/yjs9gxm5262g4vh3l7v4/en.

Validate the Email Notification Server

Use theWorkspace ONE Validation Tool to verify that your instance of VMware Email Notification Server (ENS) is properly
configured.
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1. Run theWorkspace ONE Validation Tool. Select the Email Notification Server option.

2. Configure the system integration settings to test.

o Select the System Integration you want to configure and enter the required integration information.

3. When you have entered all the required information, select Test to verify your Secure Email Gateway configuration.

4. When the test results appear, you can Export the results or Retry the validation. For more information about using
the results, see Validation Tool Results on page 36.

If the validation returns errors, consult the Pre-Installation Requirements Worksheet, available at https://resources.air-
watch.com/view/yjs9gxm5262g4vh3l7v4/en.

Validate the VMware Enterprise Systems Connector

Use theWorkspace ONE Validation Tool to verify that your instance of VMware Enterprise Systems Connector is properly
configured.

1. Run theWorkspace ONE Validation Tool. Select the Enterprise Systems Connector option.

2. Select the components to test: AirWatch Cloud Connector and VMware Identity Manager Connector. You can
select one or both components. Select Next.

3. Enter the following Certificate and DNS Validation information. The fields that appear depend on your selections on
the previous page.

a. AirWatch Cloud Connector:

l Enter the Console URL.

l Enter the AWCM URL.

l Enter the API URL.
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b. VMware Identity Manager Connector

l Enter the VMware Identity Manager URL.

l Enter the ESC URL (FQDN).

l Select Yes to integrate with RSA SecureID and enter the RSA Server URL.

l Select Yes to integrate with Horizon View and enter theHorizon View URL.

l Select Yes to integrate with Citrix-published resources and enter the Citrix URL.

4. Configure outbound connections by proxy.

o Select whether your outbound configurations operate using a proxy.

o If you select Yes, enter the Proxy URL and Proxy port, and select the Authentication type.

o If your authentication type is Password, enter theUser name, Password, and Bypass List information for your
authentication strategy.

5. System integration configurations: select Yes orNo to connect your back-end resources to Device Services

o If you select Yes, select the System Integration that you want to configure and enter the required integration
information for your selection.

6. When you have entered all the required information, select Test to verify your Enterprise Systems Connector
configuration.

7. When the test results appear, you can Export the results or Retry the validation. For more information about using
the results, see Validation Tool Results on page 36.

If the validation returns errors, consult the Pre-Installation Requirements Worksheet, available at https://resources.air-
watch.com/view/yjs9gxm5262g4vh3l7v4/en.
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Validate the Secure Email Gateway

Use theWorkspace ONE Validation Tool to verify that your instance of VMware Secure Email Gateway (SEG) is properly
configured.

1. Run theWorkspace ONE Validation Tool. Select the Secure Email Gateway option.

2. Select the SEG version (Classic SEG or V2 SEG) to test. Select Next.

3. Enter the following Certificate and DNS Validation information.

a. Enter the Server URL.

b. Enter the AWCM URL.

c. Enter the API URL.

4. Configure the system integration settings to test.

o SelectMicrosoft Exchange and enter the required integration information.

5. When you have entered all the required information, select Test to verify your Secure Email Gateway configuration.

6. When the test results appear, you can Export the results or Retry the validation. For more information about using
the results, see Validation Tool Results on page 36.

If the validation returns errors, consult the Pre-Installation Requirements Worksheet, available at https://resources.air-
watch.com/view/yjs9gxm5262g4vh3l7v4/en.

Validate VMware Identity Manager

Use theWorkspace ONE Validation Tool to verify that your Windows machine is properly configured for a deployment of
VMware Identity Manager.

1. Run theWorkspace ONE Validation Tool. Select the VMware Identity Manager option.

2. Enter the applicable Certificate and DNS Validation information.

a. VMware Identity Manager URL – Enter the URL where your Identity Manger instance resides.

b. REST API – Enter the URL of your REST API instance.

c. Integrations – Select Yes for any integration your deployment includes and enter the URL for that service.

3. Enter the Database Details.

a. Database server

b. Database name

c. Authentication type – Select SQL Server orWindows.

d. Database user (autofilled when the Authentication type isWindows)

e. Database password (automatically set when the Authentication type isWindows)
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4. Configure Proxy Settings – select Yes orNo.

a. If you select Yes, enter the Proxy URL and Proxy port for outbound connections.

b. Select the Authentication type for proxy connections.

c. If you choose Password as your Authentication type, enter a user name, password, and any URLs where you
want to bypass authentication.

5. Configure System Integrations to connect your back-end resources to VMware Identity Manager.

Select the system integration that you want to configure and enter the required integration information for your
selection.

6. When you have entered all the required information, select Test to verify your VMware Identity Manager
configuration.

7. When the test results appear, you can Export the results or Retry the validation. For more information about using
the results, see Validation Tool Results on page 36.

If the validation returns errors, consult the Pre-Installation Requirements Worksheet, available at https://resources.air-
watch.com/view/yjs9gxm5262g4vh3l7v4/en.

Validation Tool Results

Use the results from the VMwareWorkspace ONE Validation Tool to make necessary changes to your configuration to
make sure that you are ready for a successful SaaS or on-premises deployment.

If the validation tool finds errors, your results include error details for your configuration. Additional information appears
when you hover over an error in this view.
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To view additional details for each error, select Export to download a Component Test Report. Use this report to
troubleshoot your configuration.
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For more information on how to resolve errors, consult the Pre-Installation Requirements Worksheet, available at
https://resources.air-watch.com/view/yjs9gxm5262g4vh3l7v4/en.
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Database Server Installation Overview
Installing Workspace ONE UEM on premises involves configuring servers for your database before you proceed with the
installation.

Install the required database servers by completing the following:

1. Run theWorkspace ONE UEM Database Setup Utility on page 40

2. Replicate SQL Agent Jobs on Additional Database Servers on page 41

3. Verify Proper Database Installation on page 42

Run the Workspace ONE UEM Database Setup Utility
Run theWorkspace ONE UEM database executable once all prerequisites aremet, such as creating the database and the
Workspace ONE UEM SQL account and assigning DB owner roles used for installation.

For the following procedure, if you are planning to useWindows authentication, then you must be logged in as the
account you want to use or you must shift+right-click when you run theWorkspace ONE UEM database executable and
select Run as different user. The installer can be run directly on the database server, or on an application server if you
have security concerns.

Important: If there is an open connection to theWorkspace ONE UEM database, the population of the tables during
the Database setup fails.

1. On either theWorkspace ONE UEM console or Database Server, open the 9.4 DB folder, right-click theWorkspace
ONE UEM Database executable, and Run as an administrator. If you plan to useWindows authentication for SQL,
then run the installer using this account.

2. The DB Installer automatically prompts you to install any essential missing components. When complete, select
Next.

3. Accept theWorkspace ONE UEM EULA, and then select Next.

4. Select a location to install theWorkspace ONE UEM Database files, and then select Next. The best practice is to install
wherever theWorkspace ONE UEM folder exists on your system. For example, C:\Workspace_ONE_UEM.

The Database Server screen displays.

5. Click the Browse button next to theDatabase server text box and select your Workspace ONE UEM database from
the list of options.
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l If a custom port was used, do not select Browse… Instead, use the following syntax:
DBHostName,<customPortNumber> and then select Browse… to select the database server.

l Select the Server authentication use the Login ID and password below radio button and enter the SQL Admin
credentials. Click the Browse button next to the database catalog text box and select theWorkspace ONE UEM
database catalog.

TheWorkspace ONE UEM database installation user (the account used to install the database only) has DB
owner privileges on theWorkspace ONE UEM Database and SQLAgentUserRole and db_datareader on themsdb
database.

l If you are integrating SQL AlwaysOn Availability Groups, select theUsing SQL AlwaysOn Availability Groups?
checkbox. This creates a SQL Agent job for an AlwaysOn Availability Group. This job checks the status of the
server to see if it is currently the primary node or not. If the server is the primary node, it keeps the other jobs
enabled, and if not, the job disables them. The new job is named ‘AAG_EnableJobs.’

For more information about SQL AlwaysOn functionality, see Database Server Prerequisites on page 10.

6. Click Next. A warning pop-up displays to ensure the account accessing the database has sufficient rights. Click OK
and Install.

7. Click Finish once the database upgrade process completes.

8. On the SQL Server, open SQL Server Management Studio, expand theWorkspace ONE UEM database and verify
Workspace ONE UEM tables have been populated.

Replicate SQL Agent Jobs on Additional Database Servers
If you are deploying SQL Server AlwaysOn, SQL jobs are created under the SQL Server Agent during theWorkspace ONE
UEM Database deployment. These jobs must be available in all database servers which belong to the SQL Availability
Group.
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T-SQL scripts are generated from the jobs, which are then transferred to target databases and run against them to create
the same exact jobs.

After deploying theWorkspace ONE UEM Database against one of the servers, perform the following:

1. Using SSMS (SQL Server Management Studio), navigate to SQL Server Agent > Jobs. Locate the jobs for the target
Workspace ONE UEM database which follow the naming convention AirWatch_<DatabaseName> -
<JobName>, including the AAG_EnableJobs job.

2. For each Workspace ONE UEM job:

a. Right-click the job, then select CREATE TO > New Query Editor Window.

b. Save the T-SQL script to your local computer.

3. When you have saved all jobs as a script, perform the following steps:

a. Transfer all generated T-SQL scripts (for example using a file share) to the database servers which belong to the
SQL Availability group.

b. Open each T-SQL script in SSMS and run it.

c. Verify that all jobs are present by navigating to SQL Server Agent > Jobs (a refresh of the SSMS instancemight be
necessary).

4. If the SQL user account used for Workspace ONE UEM has minimal permissions, assign permission to run the AAG_
EnableJobs job by running the following command in each database server that contains the AAG_EnableJobs job:

GRANT VIEW SERVER STATE TO [AccountName]

[AccountName] is the SQL user account used to access theWorkspace ONE UEM database.

If a target database fails to join the SQL Availability Group, see https://technet.microsoft.com/en-us/library/ms178029
(v=sql.120).aspx for troubleshooting steps.

Verify Proper Database Installation
After running the database setup utility and completing installation, check to make sure that the installation was
successful.

To verify a successful installation: 

1. From SQL Server Management Studio, select your Workspace ONE UEM instance and enter:
SELECT * FROM dbo.DatabaseVersion

2. Click Execute.

3. Verify the correct version displays in the Results window. (If performing an 9.4 GA release, you seeMajorVersion 9,
MinorVersion 4, and DescriptionWorkspace ONE UEM 9.4 GA. AirWatch version 7.2 is shown as an example.)
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Application Server Installation Overview
Installing Workspace ONE UEM on premises involves configuring your application servers before you proceed with the
installation.

Install the required application servers by completing the following:

1. Run theWorkspace ONE UEM Installer on Each Application Server (Console and Device Services) on page 44

2. Generate Installation Token from myAirWatch (Automatic Method)  on page 49

3. Generate Installation Token from myAirWatch: ManualMethod  on page 52

4. (Optional) Run the Installer on Additional Application Servers on page 57

Run the Workspace ONE UEM Installer on Each Application Server (Console
and Device Services)
Run theWorkspace ONE UEM executable file on your application servers to install theWorkspace ONE UEM console and
Device Services features.

For the following procedure, if you are planning to useWindows authentication, then you must be logged in as the
account you want to use or you must shift+right-click when you run the installer EXE file and select Run as different user.

1. On the application server (which is either your Console or DS), open the 9.4 Application folder and run the
Workspace ONE UEM Application 9.4.X Full Install.exe.

Execute theWorkspace ONE UEM installer from an account with administrator privileges. If you do not have
administrative privileges, right-click and choose Run as Administrator to run the installer.

The installer stops all the services on the App server automatically.

2. The installer installs pending server prerequisites, if any.

Certain software components you might be prompted to download, such as .NET and TLS, require a reboot. Reboot
when prompted. TheWorkspace ONE UEM Installer automatically resumes after the prerequisites install.

3. Click Next once theWorkspace ONE UEM installer begins. The End User License Agreement (EULA) appears.

4. Accept the EULA and select Next.

5. Next, specify if you are importing or exporting any Workspace ONE UEM Setup Configurations from or to any other
identically configured Workspace ONE UEM servers.

l Disregard this setting if you are deploying Workspace ONE UEM without any load balanced High Availability (HA)
or Disaster Recovery (DR) servers.

l If you havemultiple load-balanced Device Services servers, then you can export settings from the first Device
Services server to use on any of the additional Device Services servers and increase install speed or import
settings that you have previously exported. For more information, see (Optional) Run the Installer on Additional
Application Servers on page 57.
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6. Select theWorkspace ONE UEM features that you want to install on the specific server.

l In a standard, multi-server environment, enable only the UEM console features or theWorkspace ONE UEM
Device Services features for the respective server type.

l If you want to enable RemoteManagement v3.0 capabilities to provide remotemanagement capabilities to your
supported devices, then refer to theWorkspace ONE UEM Remote Management v3.0 Guide, available at
docs.vmware.com, which provides steps to enable this functionality through a standalone installer.

7. TheWorkspace ONE UEM Prerequisites screen displays to ensure that you meet the requirements. At this point, the
installer checks for modules that are required for a successful deployment ofWorkspace ONE UEM. You are
prompted to install any missing components. Select Next.

8. Choose the directory to install Workspace ONE UEM, and then select Next. 

9. Enter information about theWorkspace ONE UEM Database.

l Select Browse next to theDatabase server text box and select your Workspace ONE UEM database from the list
of options. If you are using a custom port, do not select Browse. Instead, use the following
syntax: DBHostName,<customPortNumber>, and then select Browse to select the Database server.

o i.e. db.acme.com,8043

l Select one of the following authentication methods:

o ChooseWindows Authenticationmode to connect to the database, and then select Next. You are
prompted to enter the service account that you want to use. This service account is used to run all the
application pools and Workspace ONE UEM related services. This account must be an account that has
Workspace ONE UEM Database access.

o Choose SQL Server Authenticationmode to connect to the database. You are prompted to enter the user
name and password.

l Enter the name of theWorkspace ONE UEM database or browse the SQL server to select it from a list.
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10. Enter the Internal DNS URL or FQDN of the Console Server in theUEM console DNS/IP Address text box for theWeb
Console. Enter the External DNS for theDevice Services External DNS name text box for theDevice Services server.

Ensure that you are entering the full internal DNS URL or FQDN of the Console Server in the UEM console
DNS/IP Address text box. Do not enter the shortname for the server. For example, if the Console server is
awconsole.company.local, do not simply enter awconsole for your URL.

Ensure that the DNS names are correct and there are no spaces after the end of each. If an error is made, the whole
installation must be removed and reinstalled.

Select whether to enable support for the SOAP API endpoints to be SSL Offloaded by selecting API Server SSL
Offloaded?

11. If the Global EnterpriseManager screen displays, then verify your Company name.

l Enter your Company Name, which is your organization's SalesForce name provided by Workspace ONE UEM.

l Select your Environment Type from the drop-down menu.

l Enter your Installation Token from myAirWatch.

o See Generate Installation Token from myAirWatch (Automatic Method)  on page 49 if your application server
has outbound Internet access to theWorkspace ONE UEM signing service, as defined under the Network
Requirements in theWorkspace ONE UEM Recommended Architecture Guide.

o See Generate Installation Token from myAirWatch: ManualMethod  on page 52 if your application server
does not have Internet access to reach theWorkspace ONE UEM signing service.

12. Choose whether you want to participate in the VMware User Experience Improvement Program.

This program collects and uses technical information related to the performance, configuration and use of
Workspace ONE UEM to improve and benchmark its products and services, fix problems, and to advise customers
on how to use its products and services.
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13. Choose theWorkspace ONE UEM used Web site. By default, the ‘Default Web Site’ is selected.

14. If you choose to install the AirWatch Cloud Messaging component (selected by default for the Device Services
server), you receive a prompt to enter the AWCM settings:

l Enter 0.0.0.0 for the value of the listening address, which is a wildcard value that tells AWCM to listen on all
available interfaces on the server.

The value for listening address might be a specific IP address matching an interface on the server if this is needed
per your network deployment.

Use 2001 as the AWCM Services Port. Consult your Workspace ONE UEM account services representative before
using another port.

l To automatically use aWorkspace ONE UEM certificate without any additional configuration, ensureUse custom
SSL Certificate instead of built-in Workspace ONE UEM certificate? is disabled. Otherwise, select theUse
custom SSL Certificate instead of built-in Workspace ONE UEM Certificate check box and locate the PFX file of
your SSL certificate.

If you are using your own certificate, ensure that you extract the full chain as part of the PFX file before uploading
it.

l If using SSL offloading through your load balancer, enable AWCM Server SSL Offloaded? and enter in the load
balancer hostname. If you are not SSL Offloading AWCM, then you must upload your Device Services certificate
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for AWCM.

15. When deploying AWCM node(s), select a clustering mode.

l Implicit Clustering – The default, recommended method. Requires load balancer-based persistence.

l Explicit Clustering – An alternativemethod for deploying multiple AWCM Nodes that does not use load
balancer-based persistence – data is shared in memory across all nodes. For more information, see the
Workspace ONE UEM Cloud Messaging Guide.

If the SQL accounts used for Workspace ONE UEM are created with minimal permissions, you may need to script the
SQL account creation on the secondary nodes.

You will need to query the system table on the primary node to get the hexadecimalSID for the login. Use the
following query:

USE [master]
SELECT * FROM SYS.SYSLOGINS WHERE NAME LIKE ‘%LOGINNAME%’

Once you get the SID, the script below can be used to create the login on secondary nodes.

USE [master]
GO
CREATE LOGIN [SqlLogin] WITH PASSWORD=N'[Password]’, SID=[HexadecimalSID],
DEFAULT_DATABASE=[myDatabase], DEFAULT_LANGUAGE=[us_english], CHECK_EXPIRATION=
[setting], CHECK_POLICY=[setting]
GO
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16. Click Install when prompted.

If you install using Windows Server 2016, a dialog box prompts you to disable HTTP2 support. Disable and continue.

17. Click Finish once all the files are copied to the server to complete theWorkspace ONE UEM installation.

The installation log file can be viewed by selecting a check box before Finish is selected.

Internet Explorer auto-launches and may fail, since IIS has not yet fully refreshed theWeb sites.

18. Close Internet Explorer and run Chrome.

For the Console: Type https://localhost/airwatch to verify that the UEM console renders successfully.

For Device Services: Type https://localhost/devicemanagement/enrollment to verify that the device Group
ID prompt is shown.

Since the SSL certificate is not bound to the localhost session, an error displays. Select Proceed to view the site. The
first time theWeb site displays, it may take up to minute to resolve.

19. If necessary, reset IIS using the Command Prompt to bring the site online: iisreset

As part of the standard, multi-server installation, you must now go through the procedure again, this time for the other
app servers. If you have extra device services servers, then you must run the installer on each additional Device Services
server.

If you are enabling SQL AlwaysOn, you must replicate the SQL Agent Jobs on the any additional database servers. For
more information, see Replicate SQL Agent Jobs on Additional Database Servers on page 41.

Generate Installation Token from myAirWatch (Automatic Method) 

Toward the end of yourWorkspace ONE UEM installation, you may see a screen asking for your Installation Token
generated from myAirWatch. This token is used to provision the necessary secure channel certificate to yourWorkspace
ONE UEM database if it is not already present, such as in the case of a new installation.

To retrieve the token automatically, your Workspace ONE UEM application server must have outbound Internet access
to theWorkspace ONE UEM signing service, as defined under Network Requirements in theWorkspace ONE UEM
Recommended Architecture Guide.

1. After Workspace ONE UEM installation, on the Global EnterpriseManager screen, enter your Company Name and
Environment Type.

2. Select themyAirWatch link, which should open themyAirWatch website. If the token field is not displayed, then no
certificates are needed or the signing service could not be reached. If the service cannot be reached, see Generate
Installation Token from myAirWatch: ManualMethod  on page 52.
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3. Log in to myAirWatch and navigate to myAirWatch > My Company.

4. Select Certificate Signing Portal.

5. Select Authorize Install.
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6. Select Generate a Token.

7. Enter your token in the Installation Token field on the Global EnterpriseManager screen to complete the
installation.
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Generate Installation Token from myAirWatch: Manual Method 

Toward the end of yourWorkspace ONE UEM installation, you may see a Global EnterpriseManager screen asking for
your Installation Token generated from myAirWatch. This token is used to provision the necessary secure channel
certificate to yourWorkspace ONE UEM database if it is not already present, such as in a new installation.

If your Workspace ONE UEM application server does not have outbound Internet access to the signing service, as defined
under Network Requirements, then the Authentication Token field does not display on the Global EnterpriseManager. In
this case, themanual flow installer is automatically launched. In case the installer is not automatically launched, you can
manually run it by navigating toWorkspace ONE UEM/Supplemental Software/CertInstaller/ and running
CertificateInstaller.exe. This EXE file opens a screen to guide you through themanual installation method.

1. Select Next to continue and start the wizard.

2. Select whether to use SQL Authentication or Windows Authentication. Select the same option that you chose during
themain installation procedure. For SQL Authentication, the appropriate credentials are seeded in your config file.
For Windows Authentication, you must enter the credentials of theWindows user to authenticate.
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3. Select theGet File button and generate a PLIST file that contains a batch of certificate signing requests. Save this file
to a location that has outbound Internet access to themyAirWatch signing service.
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4. Log in to myAirWatch and navigate to Hamburger menu > myAirWatch > My Company.

5. Select Certificate Signing Portal.

6. Select Authorize Install.
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7. Select Upload Your File.

8. Using the link, upload a PLIST file from your computer and select the PLIST file you saved previously.
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9. Select Upload This File and save the file provided.

10. In the installer, select Set File and select the file myAirWatch provided. If successful, theNext button is enabled and
you may proceed with installation.

Installation Failed

If you see that the installation failed screen at any point during installation, then something went wrong. You can select
Back to try again or contact VMware AirWatch Support for assistance.
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(Optional) Run the Installer on Additional Application Servers
Running the installer extra times is only required if you havemore Application servers, because you must run the installer
on each additional server.

1. Log on to one of your Device Services servers and start theWorkspace ONE UEM Installer.

2. Click through the screens until you reach the Export/Import Setup Configuration form. This time, select Export
configuration and use it on multiple servers if you havemultiple load-balanced Application servers. If you only
have one Application server, then choose Continue Setup without exporting/importing config file once again.

3. Next, select theWorkspace ONE UEM features that you want to install on the specific server.

If you are installing multiple AWCMs (which are typically on the Device Services servers), then you should
refer to the following Knowledge Base article: https://support.air-watch.com/articles/115001666028.

4. Enter the file path to theWorkspace ONE UEM Directory once again, and chooseNext.

5. Enter the information about theWorkspace ONE UEM Database. Do not select the check box as there is no need to
generate a database script.

6. Enter the Console and Device Services Server URLs.

7. Specify theWorkspace ONE UEM website.

8. Click Install, and then select Finish.

9. If you have additional Device Services servers to install, run the installer on each server but import the existing
configuration file that you exported on your first Device Services server. You need to only select through the Installer
without entering any configuration details.
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Workspace ONE UEM Reports Overview
This section walks you through the process of installing Workspace ONE UEM Reports to enable report configuration,
report subscription, and data driven email for your Workspace ONE UEM deployment.

Reports Options

There are three options for configuring reporting.

l Option 1: Custom Reports

Custom reports allow you to create reports on yourWorkspace ONE UEM deployment based on your business
needs. Custom reports use a cloud-based report storage to gather data and create the reports. The custom reports
feature provides faster, easier access to critical business intelligence data than normalWorkspace ONE UEM reports.
Custom reports allow you to build customized reports using starter templates or create a report from scratch. You
can choose from a wide range of data fields such as Apps and Devices.

For more information on Custom Reports, see the Custom Reports Overview in the Report Analytics Guide,
available on docs.vmware.com.

l Option 2: New Reports

The reports functionality allows you to access detailed information about the devices, users, and applications in your
Workspace ONE UEM solution. The exports of these reports are in CSV format.

For more information on Custom Reports, see the Reports Overview in the Report Analytics Guide, available on
docs.vmware.com.

l Option 3: Legacy SSRS

TheWorkspace ONE UEM Reporting module integrates with SQL Server Reporting Services (SSRS), which is a SQL
Server module deployed with themain SQL Server instance. Sometimes the SSRS module is deployed on a separate
Server. In this case, install Workspace ONE UEM Reporting on the Server hosting SSRS.

The SSRS installer is no longer included with theWorkspace ONE UEM installation package. To add Legacy SSRS
reporting to your AirWatch v9.4 deployment, run the Reports installer for AirWatch v.9.1 in addition to your normal
Workspace ONE UEM installation, and use the documentation for that version.

Important: While your reports server can be installed on the same server as the database, a dedicated SSRS
instance is required for reports installations. Installing Workspace ONE UEM Reports on an existing production
reporting instancemay cause reporting failures.

Integrate Reports with the Workspace ONE UEM console
The final step to enableWorkspace ONE UEM Reports in the UEM console is configuring the application to use the Report
Server endpoint.

If the SQL Server is on a separate domain from the Console Server, you must enter the Domain Name of the SQL Server.

1. In the UEM console, navigate to Groups & Settings > All Settings > Installation > Reports. Ensure you are logged in
as an administrator with the System Administrator role at the Global organization group level.
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2. Enter the following parameters:

l Server URL – The Report Server URL (http://YourReportServer/reportserver by default).

l Username – TheWorkspace ONE UEM SSRS user that you created.

l Password – TheWorkspace ONE UEM SSRS user password.

l Domain Name – Enter the domain name of your active directory. This is only needed if you are using a Domain
Service Account.

Reports Storage Overview
Optimize the storage of your AirWatch Reports through reports storage. This storage feature increases the performance
of AirWatch Reports.

This storage is different than file storage used by reports, internal applications, and content. If you already use file
storage, you do not need to enable reports storage. Consider enabling reports storage if you see a performance impact
on your AirWatch database when using reports. Reports storage applies to reports only, helping increase overall reports
performance, and reducing the burden on your AirWatch database.

If you enable both file storage and reports storage, reports storage overrides file storage when storing reports.

Report storage requires a dedicated server to host the service and storage of the reports.

Reports Storage Requirements

To deploy the reports storage solution, ensure that your server meets the requirements.

Note: If you are already using File Storage, then Report Storage is available, but not required to run your
deployment. If you configure Reports Storage alongside File Storage, the report files will prioritize report storage over
file storage.

Create the Shared Folder on a Server in your Internal Network

l Report storage can reside on a separate server or the same server as one of the other AirWatch application servers in
your internal network. Ensure only the components that require access to the server can access the report storage
server, such as the Console and Device Services servers.

l If the Device Services server, Console server, and the server hosting the shared folder are not in the same domain,
then establish Domain Trust between the domains to avoid an authentication failure. If the Device Services or
Console servers are not joined to any domain, then supplying the domain during service account configuration is
sufficient.

Configure Reports Storage at the Global Organization Group

Configure reports storage settings at the Global organization group level in the AirWatch Console.
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Create a Service Account with Correct Permissions

l Create an account with read and write permissions to the shared storage directory.

l Create the same local user and password on the Console, Device Services, and the server that is being used for report
storage.

l Give the local user read/write/modify permissions to the file share that is being used for the Report Storage Path.

If you give the user modify permission, AirWatch automatically deletes old reports from the storage. If you do not
give the user modify permissions, consider monitoring report storage to prevent running out of space.

l Configure the Report Storage Impersonation User in AirWatch with the local user.

You can also use a domain service account instead of a local user account.

Allocate Sufficient Hard Disk Capacity

Your specific storage requirements may vary depending on how you plan to use reports storage. Ensure that the reports
storage location has enough space to accommodate the reports you intend to use.

For storing reports, your storage requirements depend on the number of devices, the daily number of reports, and the
frequency with which you purge them. As a starting point, plan to allocate at least 50 GB for deployment sizes up to
250,000 devices running about 200 daily reports. Adjust these numbers based on the actual amount you observe in your
deployment. Also apply this sizing to your Console server if you enable caching.

Enable Reports Storage

Enable reports storage to store your reports on a dedicated server and increase performance.

To enable reports storage, take the following stpes.

1. Navigate to Groups & Settings > All Settings > Installation > Reports.

2. Set Report Storage Enabled to Enabled.
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3. Configure the report storage settings.

Serttings Description

Report Storage
File Path

Enter your path in the following format: \\{Server Name}\{Folder Name}, where Folder Name is
the name of the shared folder you created on the server.

Report Storage
Caching Enabled

When enabled, a local copy of the files requested for download is stored on the Console server
as a cache copy. Subsequent downloads of the same file retrieve it from the Console server as
opposed to file storage.

If you enable caching, accommodate for the amount of space needed on the server where
these files cache. For more information, see Reports Storage Requirements on page 60.

Report Storage
Impersonation
Enabled

Enable to add a service account with the correct permissions.

Report Storage
Impersonation
Username

Enter the username of a valid service account with both read, write and modify permissions to
the shared storage directory.

Displays when Report Storage Impersonation Enabled is enabled.

Report Storage
Impersonation
Password

Enter the password of a valid service account with both read, write, and modify permissions to
the shared storage directory.

Displays when Report Storage Impersonation Enabled is enabled.

4. Select the Test Connection button to test the configuration.
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Installation Verification Overview
OnceWorkspace ONE UEM is installed and configured, verify that all the components you have installed function
properly.

To verify that your components are functioning correctly, complete the following:

1. Verify Correct Site URL Population on page 64

2. Verify Connectivity on page 64

3. Verify Services Are Started on page 65

4. Validate GEM Functionality on page 65

5. (Optional) Disable Services on Multiple Console Servers on page 66

Verify Correct Site URL Population
TheWorkspace ONE UEM system settings have a page that displays your site URLs. Verify these values have populated
correctly as part of the installation.

1. Open a browser and access the console using the publicly signed URL.

2. Verify theWorkspace ONE UEM version by selecting About Workspace ONE UEM.

3. Log in to theWorkspace ONE UEM console by selecting a language, if applicable, and entering your credentials.

4. Accept the terms of use.

5. Define a Password Question and/or Security PIN.

6. Verify Correct Site URL Population.

l Navigate to Groups & Settings > All Settings > System > Advanced > Site URLs and verify the URLs populated
correctly.

The only Site URL that might include “localhost” is the Peripheral Service URL. Google Play has a hostname
connected to a port number.

7. Change SOAP and REST API URLs from the UEM console URL to theWorkspace ONE UEM Devices Services server URL:

For example, https://acme-console.com/AirWatchServices becomes https://acme-ds.com/AirWatchServices and
https://acme-console.com/API  becomes https://acme-ds.com/API.

For deployments of up to 100,000 devices and higher, Workspace ONE UEM recommends a standalone API server, in
which case you should change the Site URL to match your dedicated API server URL.

Verify Connectivity
After installation, navigate to the various endpoints for each of the installed components to ensure that they are up and
running.
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1. Navigate to https://localhost/AirWatch from the Console server. An SSL error displays. Select to Proceed anyway
and then theWorkspace ONE UEM console login page displays.

2. Navigate to https://localhost/DeviceManagement/Enrollment on the Device Services server. On a device connected
through data network connection or internalWi-Fi, navigate to https://<DS_URL>/DeviceManagement/Enrollment.

3. From theWorkspace ONE UEM Devices Services Server, if that is where you installed the AWCM component, verify
AWCM communication by opening the status page: https://<DS_URL>:2001/awcm/status.

Verify Services Are Started
After installation, verify that the various services for each of the installed components are started to ensure that they are
up and running.

1. Open the Server Manager.

2. From the left pane, select Local Server then navigate to Tools > Services.

You will see all AirWatch Services at the top of the services list in alphabetical order. Each of these services start with
AirWatch in the name.

3. Verify that each of these services show Started as the Status.

Validate GEM Functionality
After installation, ensure that the GEM Inventory Service is up and running.

1. On your Console server, navigate to C:\AirWatch\Logs\Services\. Delete the AirWatchGemAgent.log file.

2. Open the Server Manager.

3. From the left pane, select Local Server and navigate to Tools > Services.
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4. You will see all Workspace ONE UEMServices at the top of the services list in alphabetical order. Each of these services
start with AirWatch in the name. For theGEM Inventory Service, right-click and select Restart.

5. Check your C:\AirWatch\Logs\Services\ folder to see if a log regenerates. If a log regenerates with errors, contact
Workspace ONE UEM Support for further assistance.

If you do not see a log file in this folder, then this is normal and you do not need to contact AirWatch Support.

(Optional) Disable Services on Multiple Console Servers
Certain Workspace ONE UEM services must only be active on one primary console server to ensuremaximum
performance. If you deploy these services, disable them on non-primary servers after you have fully installed Workspace
ONE UEM.

Workspace ONE UEM Services that must only be active on one server are:

l AirWatch Device Scheduler

l AirWatch GEM Inventory Service

l Directory Sync

l Content Delivery Service

Note: This task is only applicable if you havemultiple console servers.

Disable these services on any console servers other than the primary server:

1. On your non-primary console servers, open the Server Manager.

2. From the left pane, select Local Server and navigate to Tools > Services.

3. The activeWorkspace ONE UEM Services at the top of the services appear in alphabetical order. For the AirWatch
Device Scheduler, Directory Sync, Content Delivery Service, and AirWatch GEM Inventory Service, right-click and
select Stop.
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4. When you upgrade your UEM console, the Content Delivery Service automatically restarts. Manually disable the
applicable services again on all extra servers to maintain expected performance.
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Post-Installation Steps Overview
This guide does not cover post-install configuration, but does include two post-installation steps , which cover some of
the essential procedures to get you started.

After you complete the installation, consider:

1. Device Connection Testing on page 69

2. Run theWorkspace ONE Wizard on page 69

Device Connection Testing
Now that you have installed Workspace ONE UEM, you will want to perform some testing, such as test enrolling devices.
To do this you will need the devices themselves, such as an iPhone/iPad or Android smartphone or tablet. You will also
need to create a corporate Apple ID.

Create a Company-Dedicated Apple ID

If your deployment includes Apple iOS devices, you must generate an APNs certificate on behalf of your company. You
can easily generate this certificate post-installation but it requires an Apple ID. Because this certificatemust be renewed,
Workspace ONE UEM recommends that an Apple ID is created with an email address multiple users have access to. This
way, your company does not have to rely on one person in order to renew the certificate. If you need to create a new
Apple ID, please follow the link below and select Create an Apple ID: 

https://appleid.apple.com

Run the Workspace ONE Wizard
VMware Identity Manager is required for Workspace ONE deployments and must be configured to communicate with
yourWorkspace ONE UEM console. This process is largely automated through theWorkspace ONE UEM Getting Started
experience in the UEM console. Consider using the Getting Started wizard before attempting to use theWorkspace ONE
application.

Only run the Getting Started wizard after the health API has passed and the load balancer (if you are using one) shows
"green."

For a walkthrough of enabling VMware Identity Manager integration, theWorkspace ONE application, and core
Workspace ONE features, please see theWorkspace ONE Quick Configuration Guide, available at docs.vmware.com.

Chapter 7: Next Steps

69

VMwareWorkspace ONE UEM InstallationGuide | v.2018.05 | May 2018

Copyright©2018 VMware, Inc. All rights reserved.

https://appleid.apple.com/
http://docs.vmware.com/

	Chapter 1:  Overview
	Workspace ONE UEM Installation Overview
	Before you Begin Checklist
	Installation Procedure Checklist for Workspace ONE with Workspace ONE UEM and...

	Chapter 2: Installation Preparation
	Installation Preparation Overview
	Database Server Prerequisites
	Application Server Prerequisites
	Perform Optional Installs
	Create the Workspace ONE UEM Database
	Create the Workspace ONE UEM SQL Service Account and Assign DB Owner Roles
	Configure your Application Servers
	Configure Your Internal DNS Record and Certificates
	Configure Your External DNS Record and Certificates
	Stage Install Files
	Workspace ONE Validation Tool

	Chapter 3: Database Installation
	Database Server Installation Overview
	Run the Workspace ONE UEM Database Setup Utility
	Replicate SQL Agent Jobs on Additional Database Servers
	Verify Proper Database Installation

	Chapter 4: Application Server Installation
	Application Server Installation Overview
	Run the Workspace ONE UEM Installer on Each Application Server (Console and D...
	(Optional) Run the Installer on Additional Application Servers

	Chapter 5: Reports Integration
	Workspace ONE UEM Reports Overview
	Integrate Reports with the Workspace ONE UEM console
	Reports Storage Overview

	Chapter 6: Installation Verification
	Installation Verification Overview
	Verify Correct Site URL Population
	Verify Connectivity
	Verify Services Are Started
	Validate GEM Functionality
	(Optional) Disable Services on Multiple Console Servers

	Chapter 7: Next Steps
	Post-Installation Steps Overview
	Device Connection Testing
	Run the Workspace ONE Wizard


